Healthcode Insurance Billing

We have integrated within ClinicOffice Healthcode. This enables you to submit invoices securely to
an insurance company electronically via the Healthcode system. For the leading healthcare insurers,
this has now become the preferred method of billing. It reduces the number of returned invoices
compared with sending them yourself directly to the insurer and leads to greater efficiency for your
clinic. There are no additional charges for signing up to Healthcode.

In order to use Healthcode, you will need the following:-

e Healthcode account with Site ID
e The relevant insurer provider number
e Industry Standard Codes

Setting up Healthcode

If you already have a Healthcode account, you can enter these details into ClinicOffice by following
the steps below.

1) Go to the View menu (tab) within ClinicOffice
2) Click the Program Settings button
3) Click the Global Settings tab

4) Towards the bottom left click the blue link “Setup Healthcode Billing”

The main “Account Settings & Defaults” screen will now appear.

Healthcode Setup m] x

healthcode G5

Daline Solutians

This screen allows you to configure ClinicOffice to work with Healthcode's electronic biling system for insurance companies in the UK.

Account Settings & Defaults Provider Mumbers Item/Service Code Mapping

Enter Your Account Details
If you have not already done so, you will need to contact healthcode to setup an account with them far your dinic.
Once you have a Healthcode account, please enter your account details here :-

Site ID

Username <-MNOTE: this is your "Web Services' username

Password

@ Test Connection to Healthcode

Default / Overide Claim Properties
Use the links below if you need to set default or overidden daim properties for any of the insurers...

BUPA | BUPA International | Aviva | AXA PPP | Exeter Family Friendly | Cigna | Vitality Health | Helix
Healthcare | Western Provident Assodation | Allianz Worldwide Care | Aliance Health Group

Cancel

5) Please enter in your account’s Site ID, Username and Password
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6) Test that your account details are correct by clicking the “Test connection to Healthcode”
button

= NOTE: If you do not already have a Healthcode account, then you can always click the “Contact
Healthcode” blue link to get in contact with them in order to setup a new account.

You will note that at the bottom of the Account Settings S —

screen is a section called “Default Claim Properties”. 9 Defaults/Overides for BUP
Within this section are different links to the relevant

insurance company’s properties. For example when you @ i st o ealthende

click on BUPA the screen to the right will appear.

Claim Properties

Msg ID

The settings within this screen will always override your

other claim settings for the particular insurer you are -c...,ifglssuem e
looking at. Generally, you will not need to touch this Source Atlr Consutant
screen unless you are instructed by Healthcode to Ead:gjoealmA

change a value within your claims. For example, an Third Party Attr

insurance company might always require a particular oAt Zi;pawlnmr
Authorisation Code so you would insert such a value into cu 0

this screen. Insurer BLP

Signature Indicator
Third Party Details 1
Third Party Details2

7) Click on the Provider Numbers tab and enter in your relevant provider numbers

Healthcode Setup (m] »

‘healthcode G5

Online Solution

This screen allows you to configure ClinicOffice to work with Healthcode's electronic biling system for insurance companies in the UK.
Account Settings & Defaults Provider Mumbers Item/Service Code Mapping

I-/. .I\-I This screen allows you to specify Insurer "Provider Numbers™ for [1] your whole dinic group, [2] individual locations or [3] individual practitioners. Please contact Healthcode if you need any
'Y help with what values to put in this screen.

MName BUP BUI MNUH PPP EFS CIG 5LH HHS WPA AWC AHC
Whaole Clinic Group

[2] Clinic Locations

WRC-Willoughby Road Clinic

[3] Practitioners

Daniel O'Malley
Janet Fuller
John Smith

0K <) Cancel

If you do not know what your provider number is then Healthcode will be able to provide you with this.
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You will note that each insurance company is represented by a three symbol code; however, these
abbreviations are not always obvious in what they represent. A key chart for this is displayed below.

Insurer Insurer Name Insurer Insurer Name

Code Code

BUP Bupa BCW Simplyhealth

BUI Bupa International SLH VitalityHealth

NUH Aviva HHS Healix Health Services Ltd.

PPP AXA PPP WPA Western Provident
Association

EFS Exeter Friendly Society AWC Allianz Worldwide Care

CIG Cigna Healthcare AHC Alliance Health Corporate

8) Next click on the Item/Service Code Mapping tab

You will note that you have three columns; the first two are pulled from your items and services
grid and are stored within ClinicOffice. The third column is where you would put the industry
standard codes. The reason for this is that Healthcode will not know what your individual items or
services represent when you are submitting an invoice.

9) From here enter in the industry codes for the services that can be claimed for and click OK
once finished

Healthcode Setup

healthcode G5 FE—

Online Solution

This screen allows you to configure ClinicOffice to work with Healthcode's electronic biling system for insurance companies in the UK.

Account Settings & Defaults Provider Mumbers Item/Service Code Mapping

I-'/._.'\'-I This screen allows you to map the Items/Services in your database to the “Industry Standard Codes” which will be transmitted to Healthcode, Please contact Healthcode if you need
"W any help with what values to putin this screen.

Item Code Description Industry Standard Code N _ §
To assist with mapping your
itemsfservices, you can
export a mapping file and
send it to Healthcode.

Ice Pack Ice Pack

They will then enter the
Service mappings for you and you

can import the mapping file
DNA Missed Appointment back in to ClinicOffice.

Initial Consultation Initial Consultation = —
»  Export Mapping File

Reassessment Reassessment

Treatment Treatment 5 ImportMapping File

X-Ray X-Ray

Cancel

= NOTE: The Industry Standard Codes can be obtained from Healthcode if you do not already have
them. To assist you with this you can click the Export Mapping File, save the CSV file locally and
email it through to them. Once this has been filled in click the Import Mapping File, locate your CSV
file, select it and click open. The relevant codes will then be filled in.
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By following the above steps you will unlock the Healthcode Manager within ClinicOffice. The next
phase of the setup is to help ClinicOffice identify which contact is an insurance company.

10) Go back to the Home menu within
ClinicOffice

11) Click on the Contacts button to go to 5 Healthcode Insurer

the contacts grld | Tick here if 'BUPA' is a Healthcode Insurer

12) Locate your insurance contacts, such Healthcode insurer code: | BUP (BUPA) -

as Bupa, AXA PPP etc. by using the
Search button

Healthcode Setup. .. oK <) Cancel

13) Open the Insurance company’s record
and click the Healthcode button

14) Tick the checkbox present on the screen and select the Healthcode insurer code via the
drop down menu

15) Click OK
16) Repeat steps 12 to 15 for each insurance company you have on record

If you do not have an insurer on record but you will be billing them in the future you can create a new
contact by clicking the New button within the Contact grid and from there enter in their details. Once
done you can again follow steps 12 to 15. By doing this, when you now raise an invoice for an
insurance company the option to submit to Healthcode will be available.

The last part of the setup phase is making sure the patient has the insurer marked as their insurance
company and that they have an insurance reference entered. The next set of steps will go through
this.

17) Within the main Home menu click the upper-half of the Patients button to go to the
Patients grid

18) Open a patient’s record by double clicking on it

19) Unless customised, expand the “"More Details” group

20) Under the Payment Information fill in both the Insurance Company and Insurance Ref
fields
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Allshaw, Stephanie Mrs [1]

E-
= Save B Ol Agsign Access [ ] ). Clinical Notes Send a Message
© XA pd| 0= = v B e
.~ Undo [} Orline Diary Access o (7, Clinical Summary | [£] Tasks -
Save and Cancel Mew Duplicate  Merge Print Check Finandial 5 Pin It!
Close 7% Delete with... Password Protect - Spelling ~ | Actions ~ | £ Recall Patient [i% Flags ~

Record Actions

[ patient Details | [=!Appointments | /" Finances | || Documents | |7 AdminForms | () Privacy & Consent

L

| () More Details

Personal Information Patient Care

[ELLINGE J9EqUED

Date of Birth 15/07/1950 - Practitioner John Smith
107 71 years 5 months

General Practitioner
Height 172 am Weight 63 KG

Sex Female = | Occupation Retired Other Details

o
2
[e]
g

Marital Status | Widowed

Responsible Party
Family Head

Referred By “Mone-
Payment Information Ref By Person

Patient Status Qver 60
Acc Balance Client account: £0.00

Registration Date 13/08/2005
IInsurance Company

Clinic WRC-Willoughby Road Clinic
Invoice Redpient

IInsurance Ref IDiscount %o 0.00%

Invoice Due Days <default=

Created on 13/08/2005 12:17 by [System] | Last updated on 07/04/2022 14:37 by John Smith |

21) Click Save and Close
22) Repeat steps 18 to 21 for each patient that is paying via their insurer

The above steps are the main prerequisites that will enable you and your company to submit invoices
to your insurer via Healthcode. There may, however, be times when the invoice will still fail. We will
now consider this part way through the next subsection.

Submitting Invoices via Healthcode

In this section we will consider how you would raise an invoice and then submit it to Healthcode. If
you have not already setup your Healthcode account within ClinicOffice then it is advised that you
follow the previous section “Setting up Healthcode”.

The scenario we will consider is that an appointment has been completed for a patient that has
insurance and now an invoice needs to be raised and then submitted to Healthcode.

1) Go to the patient’s appointment within the Diary
2) Right-click on the appointment and select Create Invoice

3) Select to “Invoice the patient’s Insurance Company” (i.e. Invoice: BUPA)
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4) If you have a default charge item that you wish to use click Yes to the next message

If you do not have a default charge item for this appointment type then you can add a service to the
invoice by pressing the small + symbol at the bottom of the “Invoice Items” and then selecting the
item via the Iltem Code column. For more information on how to add a new invoice line please see the
section “Adding Lines to an Invoice”. If you wish to know how to create a default charge amount for
an appointment type please see the section “Creating a New Appointment Type”.

5) Once the correct charge amount has been inserted click the Healthcode Claim button

Healthcode Claim

9 Healthcode Claim

Invoice Date 14042022 Inv Redpient BUPA G
Invoice Mum WRC-143 Patient Allshaw, Stephanie Mrs [1]
Invoice Total £40.00 Insurer BUP (BUP)

Submit to Healthcode

) This is a new claim which has not yet been saved. Click 'Submit to Healthcode' or 'Save (Process Later)',

Claim Properties -[Show / Hide Claim History

i,
14/84/2822 13:53:49
Claim Created by John smith

Given Name Stephanie |
Registration Mo 56156156
Sex Female
Date Of Birth 15/07/1950
* Ewvent
Controlling Spedalist = AB56165

ily Mame Allshaw

Diagnosis 1
Diagnosis2
Diagnosis3
~ Invoice
Invoice No 143
Invoice Date 14/04/2022
Payee Mo ABSE165
Claim Amt 10

* Service Items
P

Healthcode Setup | Save as XML Save (Process Later)

6) This should bring up the Healthcode Claim window, click Submit to Healthcode

So long as your setup is correct the claim will automatically be submitted. If, however, something is
missing from your setup then an error message will appear under the “Claim History” section, this is
usually self-explanatory. If you do need assistance, please contact either Healthcode or Pioneer
Software (customers on our support plan can call or email our support team, non-supported
customers can post for free on our support forum forum.clinicoffice.co.uk).

Healthcode Claim Manager

Using the Claim Manager, ClinicOffice provides you with a way to overview your submitted claims,
claims that are pending and invoices that are without any claims. You can access the claims manager
by clicking on the lower-half of the Finances button and selecting Healthcode Claims. Alternatively,
you can access it by going to the Tools menu and clicking the Healthcode Claims button there. This
will bring up the window below.
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Healthcode Claim Manager

9 Healthcode Claim Manager

Date Range: | This Month

® | Show Invoices without Claims
Show Pending Claims Insurer

Show Submitted Claims

Group by:

Select All | Select None

Invoice Date Invoice Mum = Insurer = Patient Name Invoice Total Claim Status Select

=| Insurer: AVIVA,

Claim ID {CUID)

14/04/2016

1001

Chapman, Craig [8]

£30.00

None

23/04/2015

1002

Chapman, Craig [8]

£30.00

None

12/02/2015

1003

Emmett, Lisa [32]

£20.00

None

26/02/2016

1004

Emmett, Lisa [32]

£20.00

None

26/09/2016

1005

Nelson, Casey [28]

£30.00

None

Oojgogoo|iao

£130.00

Insurer: AXA PPP,

30/04/2015

1006

AMA PPP,

Barratt, Antonio [3]

£30.00

27/02/2015

1007

AXA PPP,

Barratt, Antonio [3]

£30.00

03/05/2016

1008

AXA PPP,

Beapark, Edward [34]

£20.00

12{04/2015

1009

AXA PPP,

Beapark, Edward [34]

£20.00

19/04/2015

1010

AXA PPP,

Beapark, Edward [34]

£20.00

26/04/2015

1011

AXA PPR,

Beapark, Edward [34

£20.00

10,05/2015

1012

AXA PPP,

Beapark, Edward [34]

£20.00

16/10,/2015

1013

AXA PPP,

Harvey, Andrew [15]

£30.00

17/08/2015

1014

AXA PPP,

Mossom, Bella [26]

£30.00

30/03/2015

1015

AXA PPP,

Mossom, Bella [26]

£20.00

05/02/2018

1016

AXA PPP,

Smith, Clara [22]

£20.00

O|gogoo|oo|ciooim;oic

£260.00

16 records

' Refresh | &= Print | Healthcode Setup... @ Create Healthcode Claims

[%]  Close

The first screen that you will see when opening the Healthcode Claims Manager are the invoices that
are without a claim. So these are invoices that qualify to have a claim because they are invoiced to an
insurer registered with Healthcode but as of yet a claim has not been raised. If you always submit a
claim to Healthcode whenever raising an invoice then this screen will be empty, however, this screen
does provide you with an alternative way to create claims on bulk. You can do this by clicking the
“Select All” link if you wish to create a claim for all the invoices or tick the checkbox under the
“Select” column for individual invoices and click the Create Healthcode Claims button. This screen
is also useful because it allows you to check that the invoices that need claims have actually been
created.

The Claim Manager will allow you to select a date range for your claims. By default, the grid is grouped
by the “Insurer” but you can change this so that the claims are grouped by “Month” or remove the
grouping altogether. You can also right-click on an invoice and select to open it. In the next two
screens we will consider the right-click menu will also allow you to open the individual claims as well.
You can also access the main Healthcode Setup screen from the blue link towards the bottom left.

If you are in the process of a claim and have not had time to complete but decide to save it or the
claim has failed for a reason, then these claims will show on the “Show Pending Claims” section of
the Claim Manager. The next screenshot demonstrates this.
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Healthcode Claim Manager — Pending Claims

Healthcode Claim Manager

9 Healthcode Claim Manager

_ Show Invoices without Claims
® | show Pending Claims Group by:

) Show Submitted Claims

Select All | Select None

Inwoice Date Invoice Num  Insurer = Patient Name

4 Insurer: BUPA,

09/03/2018 140 BUPA, Allshaw, Steph...

Invoice Total Claim ID (CUID)  Claim Status Select

£20.00 1 Failed |

09/03/2018 15:33:17 Submission Failed: Either 'Serviceltem.IndStdCode' or 'Serviceltem. ServiceCode' must be specified

09/03/2018 15:33: 14 Claim Created by John Smith
09/03/2018 141 ELPA,
09/03/2018 15:50:05 Claim Created by John Smith

Allshaw, Steph...

2 records

£20.00 2 Pending

' Refresh HE:] print | Healthcode Setup...

& submit to Healthcode Hﬂ Close |

By looking at the screen above the status of the claims become evident. A “Failed” status is
highlighted in red and a message of why the claim failed will be visible below the claim line. In the
example above the reason for the failure is that the invoiced item has no industry code assigned to it.
A “Pending” status is highlighted in blue and will display when the claim was initially created. You can
correct or complete a claim by right-clicking on the claim, select Open Claim, make the needed
adjustments/corrections and click Submit to Healthcode. All being well your claim should go

through.

Healthcode Claim Manager

Healthcode Claim Manager — Submitted Claims

9 Healthcode Claim Manager

! Show Invoices without Claims

Date Range: | Show Everything =

Insurer -

! Show Pending Claims Group by:

® | Sshow Submitted Claims

Select All | Select Mone

Invoice Date

Inwoice Mum  Insurer = Patient Mame

38/07/2016 | 1000514 |AVIVA, |Broakes, Andrea [4]

Claim Status
1| Submitted

Invoice Total = Claim ID (CUID)
£150.00|

28/11/2016 18:17:41 Submission Successful: Accepted for processing [1]
28112016 18:17:37 Claim Created by John Smith

10/08/2016 | 1000515 [AvIva, |Eroakes, Andrea [4]

£150.00] 2| Submitted

28/11/2016 18:18:00 Submission Successful: Accepted for processing [1]
28112016 18:17:55 Claim Created by John Smith

08/09/2015 | 1000515 [AVIVA, |Eroakes, Andrea [4]

£150.00] 3| Submitted

28112016 18:18:15 Submission Successful: Accepted for processing [1]
28112016 18:18:13 Claim Created by John Smith

29/09/2016 | 1000517 [AvIVA, |Eroakes, Andrea [4]

£150.00] 4| Submitted

28112016 18:18:42 Submission Successful: Accepted for processing [1]
28/11/2016 18:18:35 Claim Created by John Smith

20/10/2016 | 1000598  |AVIVA, |Broakes, Andrea [4]

£150.00] 5| Submitted

11112016 11:08:39 Submission Successful: Accepted for processing [1]
11112016 11:08:34 Claim Created by John Smith

10/11/2016 | 1000539 |AVIVA, [Damell, Jim [11]

£150.00] 6| Submitted

44044 MAs A4 AT L : r411

100 records

£15,000.00

Healthcode Setup...

' Refresh HE:] Print

Hﬂ Close ‘

| & update Claim Statuses
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The last section of the Claim Manager is the “Submitted Claims” and these are claims that have been
successfully submitted to Healthcode. Now, all that you need to do is wait for the insurer to either pay

the submitted claim or indicate why they are unable to. This last phase though is handled via
Healthcode’s web-based interface.

© 2026 Pioneer Software Ltd
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